
UNIT-1                  Windows operating system:

• Windows operating system is a graphical operating 
system developed by Microsoft. It allows users to view and 
store files, run the software, play games, watch videos, and 
provides a way to connect to the internet. It was released for 
both home computing and professional works.
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Features of Windows Operating System

1. Control Panel:

A Control panel is a feature of the Windows operating system that contains many tools
that help in configuring and managing the computer's resources. For e.g., the control
panel provides the settings for audio, video, mouse, keyboard, network connections,
date and time, installed applications, etc. which the user can change as per his/her need.

2. File Explorer:

It is used to display the files and folders which are on the computer. It is also known as
Windows Explorer. It gives users the ability to browse data on the hard drive, SSD, and
other inserted removable disks. It allows the user to manage the content according to
their preference such as a user can delete or rename a file, and search and transfer data.
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3. Internet Browser:
One of the major use of computers is to access the web/internet. Therefore, an internet
browser is very necessary to search for anything, view pages, do online shopping, play games,
etc. There is a pre-installed internet browser available in the Windows operating system. From
Windows 10 onwards, the Edge internet browser is the default browser, while earlier internet
explorer used to be the default browser.

4. Disk Cleanup
• One of the major tasks of an operating system is to perform cleanup operations. Disk

Cleanup is a feature of the Windows operating system that is used to free up disk
space by deleting unnecessary files or temporary files no longer required. It helps
increase the system's performance and boosts storage space to download programs
and documents. We can open disk cleanup by using the following steps:

• Open the file explorer using Window + E
• Right-click on any of the disk drives and click on the properties option from the drop-

down menu.
• Click on the Disk Cleanup option.
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What is desktop?

The desktop is a basic element of a personal computer that represents different types of
objects, including project folders, reference sources,documents . It is the primary user
interface of a computer .The desktop display is that the default display and displayed once the
startup process is complete at the time of booting the system.

The icons of files and folders that you store to the desktop are displayed on the desktop, as
well as the desktop wallpaper. In Windows operating system it includes a taskbar located at
the base of the display screen. Just like a folder, users can drag items from and to the desktop.
Accessing items from the desktop screen is very easy and can be accessed quickly, instead of
navigating through several directories. Therefore, if you store frequently used application
shortcuts, files and folders on the desktop, it may be helpful for us.
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Icons

• An icon is a small graphical representation of a program, feature, or file. When
you click or double-click an icon, the associated file or program opens or an action is
performed. For example, if you were to double-click My Computer icon, it would
open Windows Explorer. Icons are a component of GUI operating systems,
including Apple macOS X and Microsoft Windows. Icons help users quickly identify
the type of file represented by the icon
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Taskbar:
The Windows 10 taskbar sits at the bottom of the screen giving the user access to the Start
Menu, as well as the icons of frequently used applications. On the right-side, the Taskbar
features the Notification Area which informs the user of different things like the state of the
Internet connection or the charge of the laptop battery.

The icons in the middle of the Taskbar are “pinned” applications, which is a way to have a quick access to 

applications you use frequently. “Pinned” applications will stay in the Taskbar until you “unpin” them.
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• Pin an Application to the Taskbar

• Step 1 − Search for the application you want to pin in the Start
Menu.

• Step 2 − Right-click on the application.

• Step 3 − Select “More” option at the top of the menu.

• Step 4 − Select the “Pin to taskbar” option.

This will attach or “pin” the application icon to your Windows 
Taskbar.

Prepared by Prof. Satya Kumar Singha,BCA Department,Koshys 
College



Unpin an Application from the Taskbar

• To “unpin” it, just right-click the icon in the Taskbar and select “Unpin
from taskbar”. You can “pin” it back again any time you want.

Notification Area

• The Notification Area is located at the right side of the Taskbar. It shows
different types of notifications from your computer like your Internet
connection, or the volume level.

• At first, the Notification Area shows a limited amount of icons. But you
can click the upward arrow on its left-side to see other icons as well.
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Task view

• Task View allows you to quickly move within your open windows
and applications. You can access it by clicking the “Task View”
button from the Taskbar.

• You can also press and hold the Windows key, and then press Tab
to achieve the same result.

• By pressing the Alt+Tab keyboard shortcut also serves a similar
purpose.
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Control Panel:

The Control Panel in Microsoft Windows enables a user to change various computer hardware and software
features. Settings for the mouse, display, sound, network, and keyboard represent a few examples of what may
be modified in the Control Panel. Below are examples of how the Control Panel appeared in Windows.

In Windows 7, Windows 8, and Windows 10, you can use the search box in the top-right corner of the Control
Panel window to find the area you're looking to adjust.

For example, type keyboard to search for the keyboard settings in the Control Panel.
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Sections of the Windows Control Panel

• There are eight main areas on the Control Panel, containing different tools designed to
optimize your computer.

• System and Security - A section to check your computer's status, backup and restore, and others.

• Network and Internet - View network status.

• Hardware and Sound - View which devices are on your computer and add devices.

• Programs - Uninstall programs.

• User Accounts - Change user accessibility.

• Appearance and Personalization - Change desktop options, like fonts and screen readers.

• Clock and Region - Change date and time.

• Ease of access - Optimize your display settings.
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Windows Accessories

• Window Accessories Group is a very important part of the window, very important tools
are available inside Window Accessories, which we can use according to our need. Inside
the Window Accessories Group, we can calculate Mathematics, can manage the
performance of your computer, some of the important tools are:

• Calculator

• Notepad

• word pad

• Remote Desktop Connection

• Paint

• Math input panel

• snipping tool

• disk clean up

• disk defragment Prepared by Prof. Satya Kumar Singha,BCA Department,Koshys 
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Calculator:

We use this tool available in Window Accessories to do arithmetic and scientific calculations. To run the
calculator, a normal calculator is displayed on the screen, which we run with the help of a mouse so that
we can do Mathematical Sums very easily. This is an important tool of our Windows

Word pad :

Word Pad is also called a Word Processor, it is also a text editor program, it is an advanced form of note
pad. You can change the size of the font in it, we can fix the date and time, it is an important tool of
Window Accessories.

Remote desktop connection:

Remote Desktop Connection In this, we can get help by connecting remotely to the person sitting far
away, that is, the person sitting far away can operate our computer, in this, we can connect from one
computer to another computer and take any help or help anyone.

Paint:

The Paint Tool present in the Window Accessories Group is very important, with the help of this tool we
can make pictures, sketches and maps etc.
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Snipping tool:

Snipping tool is also an important tool of Window Accessories, with the help of this we can take Screen short 
(SS) of any object of the screen, with the help of this tool we can take Screen shot in the same way as we take in 
our phone.

Disk cleanup:

Disk cleanup is one of the most important tools of window accessories, with the help of this we can clean many 
things like junk files, cookies from our PC, due to this the performance of our computer becomes better.

Disk defragment:

Disk defragment is a tool of window accessories, it is used to arrange the saved file or folder in the hard disk, it 
is used to eliminate the free space on the disk drive and organize the file & folder.
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Windows explorer

File Explorer is the file management application used by Windows operating systems to browse folders
and files. It provides a graphical interface for the user to navigate and access the files stored in the
computer.

The main way to access the File Explorer is by clicking the folder icon in the Taskbar. After clicking the
icon, the File Explorer window will open.
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The initial File Explorer window is comprised of the following sections −

The File Explorer ribbon, which resembles the ribbon featured in Microsoft Office. The ribbon contains buttons 
for common tasks to perform with your files and folders.

The Navigation Pane gives you access to your libraries of documents and pictures, as well as your storage 
devices. It also features frequently used folders and network devices.

The Frequent folders section on the right features the folders you’ve worked with recently to allow for quick 
access to them.

The Recent files section in the lower part of the window features files and documents that you’ve opened
recently.
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The File Explorer Ribbon:
In Windows 10, the File Explorer features a new ribbon toolbar . This ribbon contains buttons and commands 
for the most common tasks.

The Ribbon features four tabs, each with different commands. Among the tasks you can perform from 
the Home tab are −

• Copying and pasting files and folders from one place to another.

• Moving files and folders to another location.

• Copying files and folders to another location.

• Deleting a file or folder permanently or sending it to the Recycle Bin.

• Renaming a file or folder.

• Creating a new folder or other new items.

• Verifying or modifying the Properties of a document or folder.

• Opening a file or folder.

• Different options to select one or various files and folders.
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• The Share ribbon gives you different options to share your files and folders. For example −

• E-mailing or messaging a file.

• Compressing (“Zip”) a folder to take less space.

• Printing or faxing documents.

• Sharing with other users or networks.

• The View ribbon allows you to change the way Windows displays your files and folders. Some of the
changes you can make here are −

• Adding additional panes to show a preview or details of your files.

• Changing the layout of the files and folders from icons to list, and others.

• Sorting and arranging the contents of your folder.

• Hiding selected folders or files.
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The File tab opens a menu with different options like −

Opening an additional File Explorer window.

Opening command windows for advanced users.

Prepared by Prof. Satya Kumar Singha,BCA Department,Koshys 
College



Keyboard Shortcuts in Windows
Keyboard shortcuts are keys or combinations of keys that provide an alternative way to do something that you’d typically do with a 
mouse.

Copy, paste, and other general keyboard shortcuts.

Ctrl+x                               Cut the selected item

Ctrl+C                              Copy the selected item

Ctrl+V                              Paste the selected item

Ctrl+Z                              Undo an action

Alt+Tab                           Switch between open apps

Alt+F4                             Close the active item, or exit the active app.

Windows logo + L         Lock your PC

F2                                    Rename the selected item

F3                                    Search for a file or folder in File Explorer

F5                                    Refresh the active window.

Alt+Esc                           Cycle through items in the order in which they were opened.
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Windows logo key keyboard shortcuts

Windows logo key + B   - Set focus  in the notification area.

Windows logo key + E     - Open file explorer.

Windows logo key + I      - Open Settings

Windows logo key + L      - Lock your PC or  switch accounts.

Windows logo key + M    - Minimize all windows

Windows logo key + S      - Open search

Windows logo key + T     - Cycle through apps on the taskbar

Windows logo key +  Up arrow   - Maximize the window

Windows logo key + down arrow    - Remove current app from screen or 
minimize the desktop window.
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What is internet?

The internet can be defined as a global system of interconnected computer 
networks that use the standard internet protocol suite(TCP/IP) to link 
several billion devices worldwide. 
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What is web browser?
• The web browser is an application software to explore www (World Wide Web). It provides

an interface between the server and the client and requests to the server for web
documents and services. Whenever we search anything on the internet, the browser loads a
web page written in HTML, including text, links, images, and other items . Examples of web
browsers are:

 Google chrome

 Microsoft Edge.

 Mozilla Firefox

 Safari
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How does a web browser work?

A web browser helps us find information anywhere on the internet. It is 
installed on the client computer and requests information from the 
webserver such a type of working model is called a client-server model. 

The browser receives information through HTTP protocol. In which 
transmission of data is defined. When the browser received data from 
the server, it is rendered by HTML to user-readable form and, 
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Email

• Electronic mail (e-mail) is a computer-based application for the exchange of messages
between users. A worldwide e-mail network allows people to exchange e-mail
messages very quickly. E-mail is the electronic equivalent of a letter, but with
advantages in timeliness and flexibility. A letter will take from one day to a couple of
weeks to be delivered, an e-mail is delivered to the intended recipient immediately.
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Email operations
Composing and Sending Email

• Before sending an email, we need to compose a message. When we are composing an email message, we
specify the following things:

• Sender’s address in To field

• Cc (if required)

• Bcc (if required)

• Subject of email message

• Text

• Signature

You should specify the correct email address; otherwise it will send an error back to the sender.

Once you have specified all the above parameters, It’s time to send the email. The mailer program provides a
Send button to send email, when you click Send, it is sent to the mail server and a message mail sent
successfully is shown.
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Reading Email

• In order to read an email, you just have to click on that email. Once you click a particular
email, it gets opened.

• The opened email may have some file attached with it. The attachments are shown at the
bottom of the opened email with an option called download attachment.

Forwarding Email

• It is also possible to send a copy of the message that you have received along with your own
comments if you want. This can be done using forward button available in mail client
software.

• The difference between replying and forwarding an email is that when you reply a message
to a person who has send the mail but while forwarding you can send it to anyone.

• When you receive a forwarded message, the message is marked with a > character in front
of each line and Subject: field is prefixed with Fw.
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Deleting Email

• If you don’t want to keep email into your inbox, you can delete it by simply selecting the
message from the message list and clicking delete or pressing the appropriate command.

• Some mail clients offers the deleted mails to be stored in a folder called deleted items or
trash from where you can recover a deleted email.
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Computer virus

• A computer virus is a kind of malicious computer program, which when executed, 
replicates itself and inserts its own code. When the replication is done, this code 
infects the other files and program present on your system.

• These computer viruses are present in various types and each of them can infect a 
device in a different manner.
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Types of computer virus

• Boot Sector Virus – It is a type of virus that infects the boot sector of floppy disks or the
Master Boot Record (MBR) of hard disks. The Boot sector comprises all the files which are
required to start the Operating system of the computer. The virus either overwrites the
existing program or copies itself to another part of the disk.

• Direct Action Virus – When a virus attaches itself directly to an .exe file and enters the
device while its execution is called a Direct Action Virus. If it gets installed in the memory, it
keeps itself hidden. It is also known as Non-Resident Virus.

• File Infector Virus – As the name suggests, it first infects a single file and then later spreads
itself to other executable files and programs.

• Resident Virus – A virus which saves itself in the memory of the computer and then infects
other files and programs is called resident virus. This virus can easily infect other files
because it is hidden in the memory and is hard to be removed from the system.
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Unit – 2 Microsoft Word

Introduction:

Microsoft word is a word processor software developed by Microsoft in 1983. It is the
most commonly used word processor software. It is used to create professional quality
documents, letters, reports, resumes, etc and also allows you to edit or modify your new
or existing document. The file saved in Ms Word has .docx extension. It is a component of
the Microsoft Office suite, but you can buy it separately.
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Features of MS Word

Using the features, you can perform different types of operations on your documents, like you can create, 
delete, style, modify, or view the content of your document.

1. File :  It contains options related to the file, like New(used to create a new document), Open(used to 
open an existing document), Save(used to save document), Save As(used to save documents), 
History, Print, Share, Export, Info, etc.
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2. Home
It is the default tab of Ms-Word and it is generally divided into five groups, i.e., Clipboard, Font, Paragraph, 
Style and Editing. It allows you to select the color, font, emphasis, bullets, position of your text. It also 
contains options like cut, copy, and paste. After selecting the home tab you will get below options:
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3. Insert
It is the second tab present on the menu bar or ribbon. It contains various items that you may want to insert into a
Microsoft word. It includes options like tables, word art, hyperlinks, symbols, charts, signature line, date and time, shapes,
header, footer, text boxes, links, boxes, equations, etc., as shown in the below image:

07-01-2023
Office Automation , Prepared by ,  Prof. Satya Kumar Singha, 
BCA Department,Koshys  Institute of Management Studies



4. Draw
It is the third tab present in the menu bar or ribbon. It is used for freehand drawing in Ms Word. It provides different 
types of pens for drawing as shown below:
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5. Design
It is the fourth tab present in the menu bar or ribbon. The design tab contains document designs that you can 
select, such as documents with centered titles, offset headings, left-justified text, page borders, watermarks, 
page color, etc., as shown in the below image:
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6. Layout
It is the fifth tab present on the menu bar or ribbon. It holds all the options that allow you to arrange your Microsoft Word
document pages just the way you want them. It includes options like set margins, display line numbers, set paragraph
indentation, and lines apply themes, control page orientation and size, line breaks, etc., as shown in the below image:
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7. References

This tab is the most useful for those who are creating a thesis or writing books or lengthy documents. Options like citation,
footnote, table of contents, caption, bibliography, etc. can be found under this tab.
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8. Mailings
It is the seventh tab present in the menu bar or ribbon. It is a least used tab in the menu bar. This tab is where you would 
create labels, print them on envelopes, do mail merge, etc. After selecting mailing, you will get the below options:
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9. Review
The review tab contains, commenting, language, translation, spell check, word count tools. It is good for quickly locating 
and editing comments. After selecting a review tab, you will get the options below:
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10. View 
View tab allows you to switch between single page or double page and also allows you to control the layout tools It 
includes print layout, outline, web layout, task pane, toolbars, ruler, header and footer, footnotes, full-screen view, 
zoom, etc. as shown in the below image:
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Opening  a new document:
A new, blank document always opens when you start Microsoft Word. Suppose you want to start another new document 
while you are working on another document, or you closed an already opened document and want to start a new 
document. Here are the steps to open a new document −

Step 1 − Click the File tab and select the New option.
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Step 2 − When you select the New option from the first column, it will display a list of templates in the second column. 
Double-click on the Blank document; this is the first option in the template list.

You should have your blank document as shown below. The document is now ready for you to start typing your text.
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Insert and Add Text

Step 1 − Click the location where you wish to insert text; you can also use the keyboard arrows to locate 
the place where the text needs to be inserted.

Step 2 − Start typing the text that needs to be inserted. Word inserts the text to the left of the insertion 
point, moving the existing text to the right
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Copy & Paste Operation

To use copy and paste or cut and paste operations, Word makes use of a temporary memory which is
called the clipboard. When you copy or cut a text, it stay on the clipboard temporarily and in the second
step you can paste this content at the desired location.

The Copy operation will just copy the content from its original place and create a duplicate copy of the
content at the desired location without deleting the text from it's the original location. Following is the
procedure to copy the content in word .
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Step 1 − Select a portion of the text using any of the text selection methods.
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Step 2 − You have various options available to copy the selected text in clipboard. You can make use of any one of the 
options . 

• Using Right-Click − When you right-click on the selected text, it will display the copy option, click this option to copy the
selected content in clipboard.

• Using Ribbon Copy Button − After selecting text, you can use the copy button available at the ribbon to copy the selected
content in clipboard.

• Using Ctrl + c Keys − After selecting a text, just press Ctrl + c keys to copy the selected content in clipboard.
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• Step 3 − Finally click at the place where you want to copy the selected text and use either of these two simple options −

• Using Ribbon Paste Button − Just click the Paste button available at the ribbon to paste the copied content at the desired
location.

• Using Ctrl + v Keys − This is simplest way of pasting the content. Just press Ctrl + v keys to paste the content at the new
location.
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Cut & Paste Operation
• The Cut operation will cut the content from its original place and move the content from its original location to a

new desired location. Following is the procedure to move the content in word −

• Step 1 − Select a portion of the text using any of the text selection methods.
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• Step 2 − Now, you have various options available to cut the selected text and put it in the clipboard. You can make use of
one of the options −

• Using Right-Click − If right-click on the selected portion of text, it will display cut option, just click this option to cut the
selected content and keep it in clipboard.

• Using Ribbon Cut Button − After selecting a portion of text, you can use cut button available at the ribbon to cut the
selected content and keep it in clipboard.

• Using Ctrl + x Keys − After selecting a portion of text, just press Ctrl + x keys to cut the selected content and keep it in
clipboard.
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• Step 3 − Finally, click at the place where you want to move the selected text and use either of these two
simple options −

• Using Ribbon Paste Button − Just click the Paste button available at the ribbon to paste the content at the
new location.

• Using Ctrl + v Keys − This is simplest way of pasting the content. Just press Ctrl + v keys to paste the content
at the new location.
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Find Command

The Find command enables you to locate specific text in your document. Following are the steps to find a 
word document in the following screen −

Step 1 − Let us work out on a sample text available in our Word document. Just type =rand() and press Enter; the following
screen will appear −
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Step 2 − Click the Find option in the Editing group on the Home tab or press Ctrl + F to launch the Navigation 
pane −
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Step 3 − Enter a word which you want to search in the Search box, as soon as you finish typing, Word searches
for the text you entered and displays the results in the navigation pane and highlights the word in the
document as in the following screenshot −
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• Step 4 − You can click the clear button (X) to clear the search and results and perform another search.

• Step 5 − You can use further options while searching for a word. Click the option button to display the options menu
and then click the Options option; this will display a list of options. You can select the options like match case to
perform case-sensitive search.
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Find & Replace Operation

Step 1 − Click the Replace option in the Editing group on the Home tab or press Ctrl + H to launch the Find and 
Replace dialog box shown in Step 2 −
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Step 2 − Type a word which you want to search. You can also replace the word using the Find and Replace dialog box as in
the following screenshot −
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• Step 3 − Click the Replace button available on the Find and Replace dialog box and you will see the first
occurrence of the searched word would be replaced with the replace with word. Clicking again
on Replace button would replace next occurrence of the searched word. If you will click Replace All button
then it would replace all the found words in one go. You can also use Find Next button just to search the
next occurence and later you can use Replace button to replace the found word.

• Step 4 − You can use More >> button available on the dialog box to use more options and to make your
search more specific like case sensitive search or searching for whole word only etc.

• Step 5 − Finally, if you are done with the Find and Replace operation, you can click the Close
(X) or Cancel button of the dialog box to close the box.
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Spell check

Microsoft Word provides a decent Spelling and Grammar Checker which enables you to search for and
correct all spelling and grammar mistakes in your document. Microsoft word is intelligent enough to
identify misspelled or misused, as well as grammar errors and underlines them as follows.

• A red underline beneath spelling errors.

• A green underline beneath grammar errors.

• A blue line under correctly spelled but misused words.
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Check Spelling and Grammar using Review tab

• Here is the simple procedure to find out the spelling mistakes and fix them −

• Step 1 − Click the Review tab and then click the Spelling & Grammar button.
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• Step 2 − A Spelling and Grammar dialog box will appear and will display the wrong spellings or errors in
grammar. You will also get suggestions to correct as shown below −
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Now you have following options to fix the spelling mistakes −

• Ignore − If you are willing to ignore a word, then click this button and Word ignores the word throughout the document.

• Ignore All − Like Ignore, but this ignores all occurrences of the same misspelling, not just once but throughout the
document.

• Add to Dictionary − Choose Add to Dictionary to add the word to the Word spelling dictionary.

• Change − This will change the wrong word using the suggested correct word.

• Change All − Like Change, but this changes all occurrences of the same misspelling, not just once but throughout the
document.

• AutoCorrect − If you select a suggestion, Word creates an AutoCorrect entry that automatically corrects this spelling error
from now on.
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Following are the different options in case you have grammatical mistake −

• Next Sentence − You can click Next Sentence to direct the grammar checker to skip ahead to the next sentence.

• Explain − The grammar checker displays a description of the rule that caused the sentence to be flagged as a possible
error.

• Options − This will open the Word Options dialog box to allow you to change the behavior of the grammar checker or
spelling options.

• Undo − This will undo the last grammar changed.
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• Step 3 − Select one of the given suggestions you want to use and click the Change option to fix the spelling or grammar
mistake and repeat the step to fix all the spelling or grammar mistake.

• Step 4 − Word displays a dialog box when it finishes checking for spelling and grammar mistakes, finally Click OK.
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Check Spelling and Grammar using Right Click

If you will right-click the mouse button over a misspelled word, then it will show you the correct suggestions
and the above mentioned options to fix the spelling or grammar mistake. Try it yourself.
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Insert Special Symbols

Step 1 − To insert a special symbol, bring your cursor at the place where you want to insert the symbol. Click
the Insert tab. You will find two options under the symbol button (a) Equation and (b) Symbols. Click either of
these two options based on your requirement. You will further use equations while preparing mathematical or
scientific or any similar document.
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Step 2 − When you click the Symbol button, a small list of symbols will appear as shown below.
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Step 3 − Now click on any of the available symbols in the box to insert that in your document at the selected location. If 
you do not find the desired symbol in this small box, then you can click at the More Symbols option to have a wide range 
of symbols as shown below in the symbol dialog box. You can select any of the symbol and then click the Insert button to 
insert the selected symbol.
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Insert and Add Text

First we will see how inserted text will be added into the existing content without replacing any existing content.

Step 1 − Click the location where you wish to insert text; you can also use the keyboard arrows to locate the place where 
the text needs to be inserted.

07-01-2023
Office Automation , Prepared by ,  Prof. Satya Kumar Singha, 
BCA Department,Koshys  Institute of Management Studies



Step 2 − Start typing the text that needs to be inserted. Word inserts the text to the left of the insertion 
point, moving the existing text to the right.
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To use copy and paste or cut and paste operations, Word makes use of a temporary memory which is called the clipboard.
When you copy or cut a text, it stay on the clipboard temporarily and in the second step you can paste this content at the
desired location.

Copy & Paste Operation

The Copy operation will just copy the content from its original place and create a duplicate copy of the content at the
desired location without deleting the text from it's the original location. Following is the procedure to copy the content in
word −

Step 1 − Select a portion of the text using any of the text selection methods.
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• Step 2 − You have various options available to copy the selected text in clipboard. You can make use of any one of the
options −

• Using Right-Click − When you right-click on the selected text, it will display the copy option, click this option to copy the
selected content in clipboard.

• Using Ribbon Copy Button − After selecting text, you can use the copy button available at the ribbon to copy the selected
content in clipboard.

• Using Ctrl + c Keys − After selecting a text, just press Ctrl + c keys to copy the selected content in clipboard.
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• Step 3 − Finally click at the place where you want to copy the selected text and use either of these two simple options −

• Using Ribbon Paste Button − Just click the Paste button available at the ribbon to paste the copied content at the
desired location.

• Using Ctrl + v Keys − This is simplest way of pasting the content. Just press Ctrl + v keys to paste the content at the new
location.
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Cut & Paste Operation

The Cut operation will cut the content from its original place and move the content from its original location to 
a new desired location. Following is the procedure to move the content in word.

Step 1 − Select a portion of the text using any of the text selection methods.
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• Step 2 − Now, you have various options available to cut the selected text and put it in the clipboard. You can make use
of one of the options −

• Using Right-Click − If right-click on the selected portion of text, it will display cut option, just click this option to cut the
selected content and keep it in clipboard.

• Using Ribbon Cut Button − After selecting a portion of text, you can use cut button available at the ribbon to cut the
selected content and keep it in clipboard.

• Using Ctrl + x Keys − After selecting a portion of text, just press Ctrl + x keys to cut the selected content and keep it in
clipboard.
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• Step 3 − Finally, click at the place where you want to move the selected text and use either of these two simple options
−

• Using Ribbon Paste Button − Just click the Paste button available at the ribbon to paste the content at the new location.

• Using Ctrl + v Keys − This is simplest way of pasting the content. Just press Ctrl + v keys to paste the content at the new
location.
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Change the Font Type & Size

We will understand in brief the font buttons that we will further use in this tutorial. Following is a screenshot to show you
a few font related buttons.
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Step 1 − Select the portion of text the font of which needs to be changed and click the Home tab. Now click 
the Font Type button to list down all the fonts available as shown below.
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Step 2 − Try to move the mouse pointer over the listed fonts. You will see that the text font changes when you move
the mouse pointer over different fonts. You can use the Font Scroll Bar to display more fonts available. Finally select a
desired font by clicking over the font name in the list. We have selected MV Boli as the font for our sample text.
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Step 3 − Similar way, to change the font size, click over the Font Size button which will display a font size
list. You will use the same procedure to select a desired font size that you have used while selecting a font
type.
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Text Decoration
When we use the term decorate, it means decorate by putting the text in italics, underlining the text or making
it bold to look more fancy and much more.

Making text bold

• We use bold text to give more emphasis on the sentence. It is very simple to change a selected portion of text
into bold font by following two simple steps −

• Step 1 − Select the portion of text that the font of which needs to be made bold. You can use any of the text
selection methods to select the portion of text.

• Step 2 − Click the Font Bold [ B ] button in the Home tab Font group, or simply use Ctrl + B keys to make the
selected portion of text bold.
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Change Text Color

Change Font Colors

• The text that we type comes in black by default; you can always change the color of the font to a color of your 
choice. It is very simple to change the text color by following two simple steps −

• Step 1 − Select the portion of text the font color of which needs to be changed. You can use any of the text 
selection method to select the portion of text.

• Step 2 − Click the Font Color button triangle to display a list of colors. Try to move your mouse pointer over 
different colors and you will see the text color will change automatically. You can select any of the colors 
available by simply clicking over it.

• If you click at the left portion of the Font Color button, the selected color gets applied to the text 
automatically; you need to click over the small triangle to display a list of colors.
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Highlight Text with Colors

You can highlight a selected portion of text using any color and it will look like it was marked with a highlighter
pen. Usually we highlight a text using yellow color. It is very simple to highlight a portion of text with a color by
following two simple steps.

• Step 1 − Select the portion of text that needs to be highlighted with color. You can use any of the text selection method
to select the portion of text.

• Step 2 − Click the Text Highlight Color button triangle to display a list of colors. Try to move your mouse pointer over
different colors and you will see the text color changes automatically. You can select any of the colors available by simply
clicking over it.

• If you click at the left portion of the Text Highlight Color button, then the selected color gets applied to the portion of
text automatically; you need to click over the small triangle to display a list of colors.
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Text Alignments

There are four types of paragraph alignment available in Microsoft Word —

 left-aligned, 

 center-aligned,

 right aligned,

 justified.
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Left-Aligned Text

A paragraph's text is left aligned when it is aligned evenly along the left margin. Here is a simple procedure to make a
paragraph text left-aligned.

Step 1 − Click anywhere on the paragraph you want to align and click the Align Text Left button available on the Home
tab or simply press the Ctrl + L keys.
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Center Aligned Text

A paragraph's text will be said center aligned if it is in the center of the left and right margins. Here is a simple
procedure to make a paragraph text center aligned.

Step 1 − Click anywhere on the paragraph you want to align and click the Center button available on the Home tab or
simply press the Ctrl + E keys.
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Right-Aligned Text
• A paragraph's text is right-aligned when it is aligned evenly along the right margin. Here is a simple procedure to make a

paragraph text right-aligned.

• Step 1 − Click anywhere on the paragraph you want to align and click the Align Text Right button available on the Home
tab or simply press the Ctrl + R keys.
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Justified Text

• A paragraph's text is justified when it is aligned evenly along both the left and the right margins. Following is a simple
procedure to make a paragraph text justified.

• Step 1 − Click anywhere on the paragraph you want to align and click the Justify button available on the Home tab or
simply press the Ctrl + J keys.
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Borders and Shades
Microsoft Word allows you to place a border on any or all of the four sides of selected text, paragraphs, and pages. You
can also add different shades to the space occupied by the selected text, paragraphs, and pages.

• Add Borders to Text

• Following are the simple steps to add border to any text or paragraph.

• Step 1 − Select the portion of text or paragraph to which you want to add border. You can use any of the text
selection method to select the paragraph(s).

• Step 2 − Click the Border Button to display a list of options to put a border around the selected text or paragraph.
You can select any of the option available by simply clicking over it.
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Step 3 − Try to add different borders like left, right top or bottom by selecting different options from the border 
options.
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• Step 4 − To delete the existing border, simply select the No Border option from the border options.

• Note − You can add a horizontal line by selecting the Horizontal Line option from the border options.
Otherwise type --- (three hyphens) and press ENTER. A single, light horizontal line will be created between
the left and the right margins.

07-01-2023
Office Automation , Prepared by ,  Prof. Satya Kumar Singha, 
BCA Department,Koshys  Institute of Management Studies



Add Borders to Page

You can add borders of your choice to word pages by following the steps given below.

Step 1 − Click the Border Button to display a list of options to put a border. Select the Border and Shading option
available at the bottom of the list of options as shown in the above screenshot. This will display a Border and
Shading dialog box. This dialog box can be used to set borders and shading around a selected text or page borders.
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• Step 2 − Click the Page Border tab which will display a list of border settings, styles and options whether this border should
be applied to the whole document or just one page or the first page.

• Step 3 − You can use the Preview section to disable or enable left, right, top or bottom borders of the page. Follow the
instruction given in the preview section itself.

• Step 4 − You can customize your border by setting its color, width by using different art available under the style section.
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You can have similar or even better borders as given below.
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Add Shades to Text

The following steps will help you understand how to add shades on a selected portion of text or a paragraph(s).

Step 1 − Click the Border Button to display a list of options to put a border. Select the Border and
Shading option available at the bottom of the list of options as shown in the above screenshot. This will display
a Border and Shading dialog box. This dialog box can be used to set borders and shading around a selected
portion of text or page borders.
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• Step 2 − Click the Shading tab; this tab will display the options to select fill, color and style and whether this
border should be applied to a paragraph or a portion of text.

• Step 3 − You can use the Preview section to have an idea about the expected result. Once you are done, click
the OK button to apply the result.
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Create a Table

The following steps will help you understand how to create a table in a Word document.

Step 1 − Click the Insert tab followed by the Table button. This will display a simple grid as shown below.
When you move your mouse over the grid cells, it makes a table in the table that appears in the document.
You can make your table having the desired number of rows and columns.
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Step 2 − Click the square representing the lower-right corner of your table, which will create an actual table in
your document and Word goes in the table design mode. The table design mode has many options to work with
as shown below.
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Step 3 − This is an optional step that can be worked out if you want to have a fancy table. Click the Table 
Styles button to display a gallery of table styles. When you move your mouse over any of the styles, it shows 
real time preview of your actual table.
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Step 4 − To select any of the styles, just click the built-in table style and you will see that the selected style has been applied 
on your table.
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Delete a Table

Following are the simple steps to delete an existing table from a word document.

• Step 1 − Click anywhere in the table you want to delete.

• Step 2 − Click the Layout tab, and click the Delete Table option under the Delete Table Button to delete the complete
table from the document along with its content.
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Merging Cells
Microsoft Word allows the merging of two or more cells to create one large cell. You will frequently need to merge columns
of the top row to create the title of the table. You can merge cells either row-wise or column-wise, rather you cannot merge
cells diagonally. This chapter will teach you how to merge multiple rows or columns.

The following steps will help you merge table cells in a Word document.

Step 1 − Bring your mouse pointer position inside the first cell that you want to merge. Now press the Shift key and click the
cells around the cell which you want to merge into the first cell. This will highlight the cells which you click and they will be
ready to be merged.
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Step 2 − Now click the Layout tab and then click the Merge Cells button which will merge all the selected
cells.

After merging the cells, all the content of the cells will be scrambled which you can fix later as you like. For
example, you can convert the merged cells text into title or some other description. For example, let us have
center-aligned and bigger font text as follows on top of the table.
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Split a Cell

• The following steps will help you split a cell into two sub-cells of a table available in word document.

Step 1 − Bring your mouse pointer position inside the cell that has to be divided into multiple cells.
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Step 2 − Now click the Layout tab and then click the Split Cells button; this will display a dialog box asking
for the number of rows and columns to be created from the selected cell.
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Step 3 − Select the desired number of rows and columns that have to go into the resultant cell and finally click 
the OK button to apply the result.

You can divide a cell into multiple cells either row-wise or column-wise or both.
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